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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MCP19214/5 Monitoring Graphical User Interface. Items discussed in this chapter 
include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP19214/5 Monitoring Graphical User 
Interface as a development tool to emulate and debug firmware on a target board. The 
manual layout is as follows:

• Chapter 1. “Product Overview” – Important information about the MCP19214/5 
Monitoring Graphical User Interface. 

• Chapter 2. “Installation and Operation” – Includes instructions on how to get 
started with MCP19214/5 Monitoring Graphical User Interface. 

• Chapter 3. “Graphical User Interface” – Describes the MCP19214/5 Monitoring 
Graphical User Interface and includes instructions on how to use it. 

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2016 Microchip Technology Inc. DS50002557A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
RECOMMENDED READING

This user’s guide describes how to use the MCP19214/5 Monitoring Graphical User 
Interface. Other useful documents are listed below. The following Microchip documents 
are available and recommended as supplemental reference resources.

• MCP19214/5 Data Sheet – “Digitally Enhanced Power Analog, Dual Channel, 
Low-Side PWM Controller” (DS20005681)

• MCP19215 User’s Guide – “MCP19215 Dual Boost/SEPIC Evaluation Board 
User’s Guide” (DS50002551)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site 
is used as a means to make files and information easily available to customers. Accessible 
by using your favorite Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (December 2016)

• Initial release of this document.
 2016 Microchip Technology Inc. DS50002557A-page 9
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Chapter 1.  Product Overview
1.1 INTRODUCTION
This chapter provides an overview of the MCP19214/5 Monitoring Graphical User 
Interface and covers the following topics:

• MCP19214/5 Monitoring Graphical User Interface Overview

• The Development System’s Components

1.2 MCP19214/5 MONITORING GRAPHICAL USER INTERFACE OVERVIEW

The MCP19214/5 Monitoring Graphical User Interface is a monitoring and calibration 
tool used for the MCP19214 or the MCP19215. In order to connect to the device, an 
MCP2221 USB-to-I2C bridge is used. For the MCP19215 Evaluation Board, the 
MCP2221 is incorporated on the board. The interface can collect basic parameters 
from the device: output voltage, input voltage, output current, temperature. Using the 
tool, the voltages and currents for each channel can be set and calibrated. Time 
evolution of some output and input parameters can be analyzed on graphics provided 
by the interface.

1.3 THE DEVELOPMENT SYSTEM’S COMPONENTS

To use the GUI, the following tool is required:

• The MCP19214/5 Monitoring Graphical User Interface. This Graphical User 
Interface allows monitoring and changing the input and output parameters.

For communication purposes, an MCP2221 USB-to-I2C bridge is used, incorporated 
on the board. This device allows I/O control and custom device configuration.

The interface can collect basic parameters from the device. Values, such as the output 
voltage, input voltage, output current and temperature can be monitored. The output 
voltages and currents can be modified using the MCP19214/5 Monitoring Graphical User 
Interface. The time evolution of some of the parameters measured with the internal 
Analog-to-Digital Converter (ADC) can be analyzed using the graphs provided by 
the interface.
 2016 Microchip Technology Inc. DS50002557A-page 11
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Chapter 2.  Installation and Operation
2.1 GETTING STARTED
In order to install, use and evaluate the product, there are several software and 
hardware tools required to be installed and/or set.

2.1.1 Required Software

• MCP19214_5Monitor GUI (v.1.0)

• Microsoft.NET Framework 4.5 or Higher

• Adobe® Reader

• Windows® 7

2.1.2 Required Hardware

2.1.2.1 CONNECTED BOARDS

• MCP19215 Evaluation Board (ADM00799)

2.1.2.2 COMMUNICATION TOOLS

• MCP2221 USB-to-I2C bridge – incorporated on the MCP19215 Evaluation Board

NOTICE

The MCP19214/5 Monitoring Graphical User Interface must be used with the MCP19215 
Evaluation board (ADM00799), connected to the PC, using the incorporated USB con-
nector. Otherwise, the MCP19214/5 Monitoring Graphical User Interface will not be 
completely functional.

WARNING

Use caution when changing certain parameters using the MCP19214/5 Monitoring 
Graphical User Interface as it may affect the hardware functionality. Please read the 
data sheet before changing the values provided by the Advanced Setup menu. Make 
sure a correct value is filled in as there is no verification mechanism. 

Note: The board connected to the PC has the adapter incorporated. Only a USB 
cable is needed for communication; no other adapter is required. Please 
refer to the board user’s guide.
 2016 Microchip Technology Inc. DS50002557A-page 13
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2.2 GRAPHICAL USER INTERFACE (GUI) INSTALLATION

The following steps describe how to install the MCP19214/5 Monitoring Graphical User 
Interface:

1. If the Microsoft.NET Framework is already installed, go to Step 3. If not, down-
load the Microsoft.NET Framework from www.microsoft.com and follow the 
installation instructions.

2. If Adobe Reader is already installed, go to Step 3. If not, download Adobe Reader 
from http://get.adobe.com/reader/ and follow the installation instructions.

3. Download the MCP19214/5 Monitoring GUI (v.1.0) archive from 
www.microchip.com/mcp19215, under “Documentation & Software”.

4. Unzip the MCP19214/5 Monitoring GUI (v.1.0) archive, which contains the 
setup.exe file.

5. Double click the setup.exe file to open the InstallShield Wizard window and 
wait for the extraction to complete. If required, the installation can be stopped by 
pressing the Cancel button.

FIGURE 2-1: Preparing the InstallShield Wizard for the MCP19214_5Monitor.

Note: If an older version or a corrupted version of the current 
MCP19214_5Monitor is already installed on the computer, please see 
Section 2.4 “MCP19214_5Monitor Software Uninstall” before 
proceeding with the installation.
DS50002557A-page 14  2016 Microchip Technology Inc.



Installation and Operation
6. In the Welcome to the InstallShield Wizard for MCP19214_5Monitor window, 
click on the Next button to start the installation.

FIGURE 2-2: Starting the MCP1921_5Monitor Installation.

7. Review and accept the License Agreement by checking the I accept the terms 
in the license agreement option button, then click on the Next button.

FIGURE 2-3: The License Agreement Window.
 2016 Microchip Technology Inc. DS50002557A-page 15
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8. The installation path can be changed, although it is recommended to keep the 
default path. Click on the Next button to continue.

FIGURE 2-4: Selecting the Destination Folder.
DS50002557A-page 16  2016 Microchip Technology Inc.



Installation and Operation
9. In the Ready to Install the Program window, click on the Install button and wait 
for the application to proceed with the installation. The progress can be observed 
in the “Status” bar.

FIGURE 2-5: Installing the MCP19214_5Monitor.
 2016 Microchip Technology Inc. DS50002557A-page 17
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10. Once the installation completes, leave the Launch the program box checked to 
automatically start the MCP19214_5Monitor user interface or deselect this check 
box to start the GUI at a later stage. Click Finish to end the installation. 

To start the GUI at a later stage, either click on the desktop icon or browse to 
Windows Start>All Programs>Microchip>MCP19214_5Monitor.

FIGURE 2-6: The Installation Complete Window.

11. The interface will display the Basic Settings menu; the scan address and the 
connect functions will be active.

FIGURE 2-7: Initial Basic Settings Menu.
DS50002557A-page 18  2016 Microchip Technology Inc.
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2.3 DRIVER INSTALLATION FOR THE ADAPTER

If the USB integrated on the board is used, the computer should automatically install 
the appropriate driver when the evaluation board is connected. If the driver is not 
installed automatically after installing the GUI, the following steps describe the 
installation process.

1. Go to Windows Start>Control Panel>System and Security. Choose System from 
the right panel and click Device Manager from the left pane to open the list of 
installed hardware. In the “Other devices” list, identify a USB unknown 
connection.

Right click on the unknown driver and click on “Update Driver Software”.

FIGURE 2-8: Device Manager – Update Driver.
 2016 Microchip Technology Inc. DS50002557A-page 19
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2. In the Update Driver Software window, click on “Browse my computer for driver 
software” option.

FIGURE 2-9: Browse Computer for Driver.

3. Click on the Browse button and select the path where the GUI was installed.

If the path was left unchanged, go to the 
C:\Program Files (x86)\Microchip\MCP19214_5Monitor folder and click the OK button.

Click Next to start the driver installation.

FIGURE 2-10: Selecting the Path.
DS50002557A-page 20  2016 Microchip Technology Inc.
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FIGURE 2-11: Installing the Driver Software.

4. If the following warning message appears, select the “Install this driver anyway” 
option; otherwise, skip this step.

FIGURE 2-12: Warning Message.
 2016 Microchip Technology Inc. DS50002557A-page 21
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If the driver was successfully installed, the following window will appear:

FIGURE 2-13: Installing the Driver Software.

After installation, the device should be recognized in the Device Manager; otherwise, 
remove and plug in the USB cable again.

FIGURE 2-14: USB Recognized.
DS50002557A-page 22  2016 Microchip Technology Inc.
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2.4 MCP19214_5MONITOR SOFTWARE UNINSTALL

In order to install the current MCP19214_5Monitor version, any previous or corrupted 
version should be removed from the computer.

If there is an older version installed on the computer, the message box from Figure 2-15 
will be displayed in Step 5 of the GUI installation process. Uninstall the older version 
from Windows Start>Control Panel>Programs>Uninstall a Program, then go to Step 5 
to resume the installation.

FIGURE 2-15: Windows® Installer Message Box.

If the current MCP19214_5Monitor version is already installed on the computer, in 
order to have a clean install, the message box in Figure 2-16 will be displayed in Step 
6 of the GUI installation process. In this case, follow the next steps to uninstall the 
current version of the MCP19214_5Monitor:

1. Select the Remove option button, then click the Next button.

FIGURE 2-16: The Program Maintenance Window.
 2016 Microchip Technology Inc. DS50002557A-page 23



MCP19214/5 Monitoring Graphical User Interface User’s Guide
2. In the Remove the Program window, click the Remove button to remove the 
current MCP19214_5Monitor version from the computer.

FIGURE 2-17: Removing Previous Installations.

3. When the MCP19214_5Monitor completes the uninstall process, click on the 
Finish button, then go to Step 5 to resume the installation of the 
MCP19214_5Monitor GUI.

FIGURE 2-18: Uninstalling the MCP19214_5Monitor.
DS50002557A-page 24  2016 Microchip Technology Inc.
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Chapter 3.  Graphical User Interface
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3.1 INTRODUCTION

This chapter describes how to use the GUI and the MCP19214/5 device characteristics 
that are included and monitored.

FIGURE 3-1: Graphical User Interface – Initial Screen.

3.2 GRAPHICAL USER INTERFACE DESCRIPTION

The following sections describe the items in the Graphical User Interface.

3.2.1 Menu Bar

The menu bar contains the items available for the user to display the device’s 
characteristics and settings, as shown in Table 3-1.

FIGURE 3-2: Menu Bar.



Graphical User Interface
3.2.2 Connection Bar

The connection bar contains the items in Table 3-2.

FIGURE 3-3: Connection Bar.

3.2.3 Status Bar

The status bar provides information on the status of the device connected to the PC. 
This bar is available in all the menus.

FIGURE 3-4: Status Bar.

The items available in the status bar are shown in Table 3-3.

TABLE 3-1: MENU BAR ITEMS

Item Description

Basic Settings Displays the Basic Settings menu.

Hardware Setup Displays the Hardware Setup menu.

Advanced Setup Displays the Advanced Setup menu.

Statistics Displays the Statistics menu.

About Shows information about the version of the product.

Help Opens a PDF document with details on the MCP19214/5 Monitoring 
Graphical User Guide.

TABLE 3-2: CONNECTION BAR ITEMS

Item Description

Addr This drop-down menu shows the address of the I2C protocol device.

Connector This drop-down menu shows the type of connector used to connect 
the board to the PC. The connector is automatically recognized. 
Connect the MCP19214/5 board to the PC by using the USB port on 
the MCP19214/5 board. In this case, the MCP222X integrated in the 
MCP19214/5 board is used to perform the communication.

ScanAddr This button is used to scan for PMBus protocol devices connected to 
the PC.

Connect/Disconnect These buttons are used to connect/disconnect the PMBus protocol 
device.(1)

Voltage This drop-down menu is used to select the voltage level of the I2C 
communication interface.

Rate This drop-down menu is used to select the corresponding 
communication rate for the device.

Pullups This drop-down menu allows enabling/disabling pull-ups.

Note 1: The Disconnect button is disabled when the ScanAddr and Connect buttons are 
enabled, and enabled when the ScanAddr and Connect buttons are disabled.
 2016 Microchip Technology Inc. DS50002557A-page 26
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3.2.4 Basic Settings Menu

The Basic Settings menu is the first tab displayed when opening the 
MCP19214_5Monitor.

FIGURE 3-5: Initial Basic Settings Menu.

The Basic Settings menu is used to monitor the MCP19214/5 device parameters, to 
enable/disable the converter, to store/restore values and to set output parameters. The 
items found in the Basic Settings menu are shown in Table 3-5.

TABLE 3-3: STATUS BAR ITEMS

Item Description

Status Label The status label on the bottom of the GUI shows if there is any 
device connected to the board. Refer to Table 3-4 for a list of 
possible labels.

Progress Bar The progress bar completes after scanning for the I2C address or 
when disconnecting from the device.

Error Label When a communication error happens, an error label appears 
between the Status Label and Progress Bar 

TABLE 3-4: STATUS LABELS

Status Label Description

STATUS: Connected! This message is shown when the GUI detects a device connected 
to the board.

STATUS: Disconnected! This message is shown when the GUI does not detect any device 
connected to the board.
 2016 Microchip Technology Inc. DS50002557A-page 27
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3.2.5 Hardware Setup Menu

The Hardware Setup menu allows setting the resistors’ values for the output 
feedback dividers and the values for the output shunt resistors. Current values can be 
saved or older values can be loaded.

FIGURE 3-6: The Hardware Setup Menu.

The items found in the Hardware Setup menu are shown in Table 3-6.

TABLE 3-5: BASIC SETTINGS MENU ITEMS

Category Item Description

Status VIN Shows the input voltage value. 
This parameter is common for both channels.

TEMP Shows the temperature value in Celsius. 
This parameter is common for both channels.

VOUT Shows the output voltage value.
This parameter is monitored for each channel.

IOUT Shows the output current value. 
This parameter is monitored for each channel.

ON/OFF These buttons are used to enable/disable the converter 
for each channel.

Status messages Shows if the voltage/current loop are in regulation (loop 
closed) or out of regulation (loop opened).

User Settings VOUT Shows the output voltage value set by user. 
This parameter can be set separately for each channel.

IOUT Shows the output current value set by user. 
This parameter can be set separately for each channel.

SET These buttons are used to change the previous value 
set by user with the new value from the VOUT/IOUT 
fields.
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3.2.6 Advanced Setup Menu

The Advanced Setup menu is used to compensate and calibrate the board. It contains 
a Settings tab and a Calibration tab.

TABLE 3-6: HARDWARE SETUP MENU ITEMS

Panel Item Description

Voltage R1 Shows the value of the first resistor from the output divider for 
each channel.(1)

R2 Shows the value of the second resistor from the output divider 
for each channel.(1)

SET These buttons are used to set the resistors from the output 
divider for each channel separately.

Current Shunt Shows the value for the output shunt resistor for each channel.

SET These buttons are used to set the output shunt resistors for 
each channel separately.

Save profile This button saves the resistors’ values for the output feedback 
divider and the values for the output shunt resistors for both 
channels.

Load profile This button loads the resistors’ values for the output feedback 
divider and the values for the output shunt resistors for both 
channels.

Note 1: The values loaded are the last values used, or the default values, if the Graphical 
User Interface has just been installed.

WARNING

Use caution when changing certain parameters as it may affect the hardware function-
ality. Make sure a correct value is filled in as there is no verification mechanism. Please 
read the data sheet before changing the values provided by this menu.
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3.2.6.1 Settings TAB

The Settings tab is used to compensate the board. The user can change the values 
from the registers provided and read back the values changed.

FIGURE 3-7: The Advanced Setup Menu – Settings.

The items found in the Advanced Setup menu, Settings tab, are shown in Table 3-7.

TABLE 3-7: ADVANCED SETTINGS MENU ITEMS

Item Description

Slope compensation Holds the digital value that controls the slope compensation 
ramp.

LOOPCON1/LOOPCON2 Holds the control bits for the I/V loops for each PWM channel. 
The outputs from the IVGOOD and IVDOM comparators can be 
read from this register for each channel.

I Peak Sense Offset Holds the digital value that controls the input current offset 
adjust.

I Peak Sense Blanking Holds the digital value that controls the Leading-Edge Blanking 
(LEB) time on the primary input current.

VREFCON1/VREFCON2 Holds the digital value that controls the DAC voltage reference 
(VREF), which sets the voltage regulation value for each 
channel.

CREFCON1/CREFCON2 Holds the digital value that controls the DAC current reference 
(CREF), which sets the current regulation value for each 
channel.

SET These buttons are used to set register values, to write them on 
the board. 

Load This button reads back the values from the device and updates 
the fields with the new values read.
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3.2.6.2 Calibration TAB

The Calibration tab is used to calibrate the board. The user can change the values 
from the registers provided and read back the values changed. This tab will be used for 
testing purposes only. The part is calibrated in the factory.

FIGURE 3-8: The Calibration Tab.

The items found in the Advanced Setup menu, Calibration tab, are shown in Table 3-8.

TABLE 3-8: CALIBRATION TAB ITEMS

Item Description

GMCAL1/GMCAL2 Trims the transconductance of the error amplifiers.

DCSCAL1/DCSCAL2 Trims the offset of the 10x differential amplifiers.

ADBT Trims the offset of the 1x/2x measurement amplifier.

DACBGRCAL Trims the band gap reference voltage and the DAC modules’ 
currents.

PDSCAL Trims the pedestal voltage.

VRCAL Trims the 4.096V reference voltage.

OSCCAL Trims the internal oscillator.

EACAL1/EACAL2 Trims the offset of the error amplifiers.

DACCAL1/DACCAL2 Trims the full range current of the DACs.

SET These buttons are used to set register values, to write them on the 
board.

Load This button reads back the values from the device and updates the 
fields with the new values read.

IS_GAIN Contains the amplifier gain used to compute the output current 
values for each channel
 2016 Microchip Technology Inc. DS50002557A-page 31



Graphical User Interface
3.2.7 Statistics Menu

The Statistics menu is used to monitor, in time, different A-D converter channels – 
parameters chosen from a selection box.

FIGURE 3-9: The Statistics Menu.

The items found in the Statistics menu are shown in Table 3-9.

TABLE 3-9: STATISTICS MENU ITEMS

Item Description

Enable Analog Test Interface When this box is checked, the Set button is activated, the A/D 
Converter stops reading and the analog interface is activated. 
The parameters selected with the ADC selection box can be 
measured on the board.

ADC Use this selection box to choose the characteristic to monitor.

Coordinate All the characteristics monitored and displayed in the graph 
area are read with the A/D Converter.

Start Use this button to start monitoring the chosen characteristic 
and to start generating the graph.

Stop Use this button to stop scrolling the graph and to stop 
generating the graph.

Set This button sets the analog characteristic that can be mea-
sured on board.

Graph area This area displays the graph created while monitoring the 
chosen characteristic.
 2016 Microchip Technology Inc. DS50002557A-page 32



Graphical User Interface
3.2.8 About Menu

The About menu includes the MCP19214_5Monitor version number.

FIGURE 3-10: About Menu.

3.2.9 Help Menu

The Help menu opens the current user’s guide in PDF format.

3.3 USING THE MCP19214/5 GRAPHICAL USER INTERFACE
To perform the communication between the board and the PC, follow these steps:

1. Connect the board to the PC, using the on-board incorporated USB. The 
connector is automatically detected by the interface.

2. Change the option from the Rate drop-down menu if needed. The “5V” option 
from the Voltage drop-down menu and the “enabled” option from the Pullups 
drop-down menu are automatically selected.

FIGURE 3-11: Connection Toolbar.

3. Press on the ScanAddr button. If the board is connected, the address will be 
shown in the Addr drop-down menu. If there are several addresses, manually 
select the correct address of the board from the list of available addresses (0x55 
for the MCP19215 board). Then, press the Connect button for the communication 
to start running.

4. In the Hardware Setup menu, set the resistors for the output feedback divider 
and the output shunt resistor.

5. In the Basic Settings menu, under the User Settings panel, set the output voltage 
and current for each channel. 

FIGURE 3-12: User Settings Panel.
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6. Press the ON button to start the measurements for the output voltage and 
current. Press the OFF button to turn off the converter. 

FIGURE 3-13: Basic Settings Menu – Status Section.

To close the communication between the GUI and the board, press the 
Disconnect button from the Connection bar, then resume from Step 1.

7. In the Advanced Setup menu, change any parameter, as applicable, and click the 
SET button from the corresponding field with the changed data. The Calibration 
tab is used only for testing purposes.

8. In the Statistics menu (Figure 3-14), select one of the options in the “ADC” selection 
box to display the corresponding graph. The following options are available:

• When clicking the Start button, the time coordinate will be displayed on the 
X axis in seconds and the selected coordinate will be displayed on the Y axis 
using the corresponding measurement unit – ADC units.

• Clicking the Stop button will allow selection of another coordinate for generating 
the graph.

• If the Enable Analog Test Interface box is checked, the Start and Stop 
buttons will be disabled; the Set button will be enabled. Pressing on the Set 
button will activate the analog interface and the selected parameter in the 
ADC selection box can be measured.

WARNING

It is recommended to read the “MCP19214/5 Data Sheet” before changing any values in 
the Setting or Calibration tabs.

Note: The Start button will be disabled until the Stop button is pressed.
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FIGURE 3-14: Statistics Menu.

9. The device calibration is now complete. Click the StoreAll button in the Basic 
Settings menu to retain the values after the device has been powered off, or on 
the RestoreAll button to return to the default values.

10. Disconnect the board from the PC to end the communication.
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